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Abstract: Excel: Charting is a workshop for students who want to learn 
how to use Excel to create and edit charts, modify chart options, 
and format chart objects, as well as use trendlines, forecasts, and 
error bars to present data graphically. 
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Introduction 
A chart is a graphic representation of worksheet data that can offer visual analysis of 
information. Excel offers a variety of different charts. Some chart types are set with a 
two-dimensional (2-D) perspective, while other chart types are set with a three-
dimensional (3-D) perspective. There are a number of built-in formats for each chart type 
and custom formatting is available to create exactly the chart desired. A chart may be 
created on an existing worksheet, a separate worksheet, or in a different document 
altogether. A chart created within an existing worksheet that includes the charted data is 
referred to as an embedded chart; it is saved as part of the worksheet. A chart that is 
created on a separate worksheet is known as a chart sheet. Both types of charts are linked 
to the source worksheet and are updated when the source data is edited. Charts can also 
be embedded into other Microsoft Office applications, like Word or PowerPoint. 

Objectives 
• Create and edit charts 

• Modify chart options 

• Format chart objects 

• Apply trendlines and error bars 

Prerequisites 
Excel: Introduction or equivalent knowledge. 

Related Training Available from Instructional Services 
All workshops offered by Instructional Services are free to KU students, staff, faculty, 
and approved affiliates. 

To learn more about or register for workshops, receive automatic announcements of 
upcoming workshops, and track workshops you’ve registered for and have attended, visit 
www.lib.ku.edu/instruction/workshops. For further workshop related questions, please 
email training@ku.edu. 

Definitions 

Term Definition 

Cell Range A series of selected or related cells. 

Axis A line that borders one side of the plot area, providing a frame of reference 
for measurement or comparison in a chart. For most charts, data values 
are plotted along the value axis, which is usually vertical (the y-axis), and 
categories are plotted along the category axis, which is usually horizontal 
(the x-axis). 
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Term Definition 

Gridlines Lines that you can add to a chart to make it easier to view and evaluate 
data. Gridlines extend from the tick marks on an axis across the plot area. 

Data Label A label that provides additional information about a data marker, which 
represents a single data point or value that originates from a worksheet 
cell. Data labels can be applied to a single data marker, an entire data 
series, or all data markers in a chart. Depending on the chart type, data 
labels can show values, names of data series or categories, percentages, 
or a combination of these. 

Data Series A group of related data points that are plotted in a chart. Each data series 
in a chart has a unique color or pattern and is represented in the chart 
legend. You can plot one or more data series in a chart. Pie charts have 
only one data series. 

Data 
Marker 

A bar, area, dot, slice, or other symbol in a chart that represents a single 
data point or value that originates from a worksheet cell. Related data 
markers in a chart constitute a data series. 

Plot Area In a 2-D chart, the area that’s bounded by the axes and includes all data 
series. In a 3-D chart, the area that’s bounded by the axes and includes 
the data series, category names, tick-mark labels, and axis titles. 

Legend A box that identifies the patterns or colors that are assigned to the data 
series or categories in a chart. 

Trendline A graphical representation of the trend, or direction, of data in a series. 
Trendlines are used for the study of problems of prediction, also called 
regression analysis. You can add trendlines to data series in unstacked 
2-D area, bar, column, line, stock, xy (scatter), and bubble charts. 

Error Bars Graphic bars that express potential error (or degree of uncertainty) relative 
to each data marker in a series. You can add y error bars to data series in 
2-D area, bar, column, line, xy (scatter), and bubble charts. Bubble and xy 
charts can also display x error bars. You can select error bars and format 
them as a group. 

Data Table A grid that can be added to some charts and contains the numeric data 
used to create the chart. The data table usually is attached to the category 
axis of the chart and replaces the tick-mark labels on the category axis. 

Tick Marks Tick marks are small lines of measurement, similar to divisions on a ruler, 
that intersect an axis. Tick-mark labels identify the categories, values, or 
series in the chart. Tick-mark labels come from the cells on the worksheet 
used to create the chart. 
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Chart Wizard Button 

 

Creating a Chart 

Using the Chart Wizard 
Excel’s Chart Wizard leads you through the steps for creating a chart. There are four 
main dialog boxes the Chart Wizard presents to you during the process. Once the chart is 
created, you can access any one of the dialog boxes to edit the chart. 

To create a chart using the Chart Wizard, use the following steps: 

1. Click and drag across the cells that contain the data you want to chart. The cell 
selection can include any data labels that you want to display on the chart. 

2. Click the Chart Wizard button on the Standard toolbar: 

 

  

 

 Excel displays the Chart Type dialog box:  

 

3. In the Chart type list, click the chart type you want. 

4. Under Chart sub-type, click the chart sub-type you want. 
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5. Click Press and Hold to View Sample to see a preview of your chart: 

 

Excel displays a miniature version of the chart type you have selected. 

6. Release the mouse button after you view the sample. 
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7. Click Next. Excel displays the Chart Source Data dialog box. 

 

8. To display the data properly you can change the chart orientation to read the data in 
Rows or in Columns by selecting the appropriate option. 

9. Click Next. Excel will display the Chart Options dialog box. 
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10. There are several options to add to your chart. For example you can: 

a. Add titles for the chart and its axes 

b. Modify the scale of the chart axes 

c. Add or remove gridlines 

d. Control the placement of the chart legend 

e. Add value or percent labels to each data series 

f. Add a data table to your chart 

11. Click Next. Excel displays the Chart Location dialog box: 

 

12. Choose to create the chart either as a new sheet or as an object embedded in the 
existing sheet. 

13. Click Finish to complete the process. 
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Modifying Charts 
Once your chart is created, you can modify the look of your chart as well as the data that 
is displayed in it.  

When you click on a chart to select it, the Chart toolbar becomes available. (If the Chart 
toolbar does not display, you can click the View menu, point to Toolbars, then click 
Chart.) 

 

You can access any of the four steps of the Chart Wizard from the Chart menu: 

 

The Chart Wizard steps can be accessed in the Chart menu. 

Using either the Chart toolbar or the Chart menu, you can make changes to the structure 
of your chart. For example: 

• You can change the chart type by using the Chart Type command on the Chart 

menu or using the Chart Type  button on the Chart toolbar. 

• You can add more data to your chart by using the Source Data command on the 
Chart menu. 

• You can add/remove data labels on your chart by using the Chart Options command 
on the Chart menu. 

• You can move an embedded chart to its own chart sheet by using the Location 
command on the Chart menu. 

Formatting Chart Objects 
Excel creates charts by bringing several different graphic objects together. Most 
individual objects can be selected and modified as needed. The key is to first select the 
object you want to modify. The Chart toolbar can be very helpful when selecting the 
appropriate object because it contains a list of all of the objects on your chart. Once you 
have selected the object you want to format, click the Format menu.  
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Formatting the Color of the Plot Area 
1. Click the Chart Objects drop-down list on the Chart toolbar. 

 

2. Select Plot Area from the list. 

3. Click the Format  button. 

4. Click the Color drop-down palette in Format Plot Area dialog box. 

 

5. Click to select a color from the color palette. 

6. Click OK to accept the change. 

Changing the Font of an Axis 
1. Double-click the y-axis line. 

2. Click the Font tab of the Format Axis dialog box. 
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3. Select options such as the Font, Font style, Color and Size. 

4. Click OK to accept the changes. 

Modifying the Scale of an Axis 
1. Right-click the y-axis. 

2. Select Format Axis from the shortcut menu. 

 

3. Click the Scale tab in the Format Axis dialog box. 



Instructional Services 
Excel: Charting 

Instructional Services at KU Libraries - 12 - © 2006 The University of Kansas 
A Division of Information Services 

 

4. Change, for example, the Major unit to 50. 

5. Click OK to accept the changes. 

Changing the Color/Pattern of a Data Marker 
1. Click on a data series. 

2. Click the Format menu. 

3. Click Selected Data Series. 
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4. Select basic color and/or border options, or click Fill Effects for more options.  

 

5. Click OK to accept changes. 

Plotting a Data Series as a Different Chart Type 
Suppose you want to work with a chart that contains one student’s scores. For 
comparison purposes, you also want include the data that show class averages. However, 
you would like to see the student’s data displayed as a bar chart, and the average data as a 
line chart. 

1. Click on the chart. 

2. Click on the data series you want to display as a different chart type. 
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3. Click the Chart Type menu on the Chart toolbar, and select the type you want to 
use. 

 

The Chart Type menu on the Chart toolbar 

Trendlines 
A trendline is a graphical representation of the trend, or direction, of data in a series. 
Trendlines are used for the study of problems of prediction, also called regression 
analysis. You can add trendlines to data series in unstacked 2-D area, bar, column, line, 
stock, xy (scatter), and bubble charts.  

Adding a Trendline to a Chart 
1. Click on the chart.  

2. Click the Chart menu and select Add Trendline. 
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3. In the Add Trendline dialog box, select the Trend/Regression type. 

When you want to add a trendline to a chart, you can choose any of the six different 
trend/regression types. The type of data you have determines the type of trendline 
you should use. 

4. Click OK to accept the changes. 

Pie Charts 
A pie chart shows the size of items that make up a data series, proportional to the sum of 
the items. It always shows only one data series and is useful when you want to emphasize 
a significant element. 

Creating a Pie Chart 
1. Click and drag to select the range of data you want included in your chart. 

2. Click the Chart Wizard button. 

3. In the Chart Type dialog box select the Pie Chart type. 
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4. Click a Chart sub-type. 

5. Click Next. 

6. In the Chart Source Data dialog box, click to change the Data range if necessary. 

7. Click to change the chart orientation to Rows or Columns if necessary. 

8. Click Next. 

9. In the Chart Options dialog box type in the Chart title. 

Add Data Labels 
10. In the Chart Options dialog box, click the Data Labels tab. 

11. Select an option under Label Contains. 
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12. Click Next. 

13. In the Chart Location dialog box, choose a location for the chart. 

14. Click Finish to create the chart. 

Printing Charts 
Charts can be printed as part of a spreadsheet or as a separate object. 

Printing an Embedded Chart on a Separate Page 
1. Click the chart you want to print to select it. 

2. Click the File menu and click Print. 

3. Enter the Number of copies you want.  

4. Click OK. 

Getting Additional Help 
The Help Desk provides consulting and Q&A help in a variety of ways: 

785/864-0200 
question@ku.edu 
www.ku.edu/~helpdesk 
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